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PowerSearch: Install & Requirements
About This Manual
While the manual is a good resource, we recommend checking out the videos on PowerSearch to
really get an understanding of how it works. Often it’s easier to show something than to try to explain it
with words, especially with something that’s visual to begin with.
However, it can be hard to go into lots of detail in a video, so this manual usually provides more info
than you’ll find in the tutorial videos. The videos and manual are designed to complement each other.

Online Tutorials
https://digitalanarchy.com/premiere-search/tutes.html
Some great tutorials on the various features, especially Indexing as well on how to use
PowerSearch with other services such as SimonSays, Trint, and Speedscriber.
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PowerSearch: Install and Requirements
Installation
You can always download the most up-to-date version of PowerSearch from our Demo page. Your serial number will activate
the demo.
If you own Transcriptive 2.0 or later, your serial number will activate PowerSearch.

Mac Demo:
https://digitalanarchy.com/demos/psd_mac.html
Download the .dmg file and run the Installer that’s on the dmg.

This will install the PowerSearch panel and associated files into:
Macintosh HD/Library/Application Support/Adobe/CEP/
Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close
the installer.
Restart Premiere Pro and PowerSearch should show up in Premiere under Windows>Extensions>PowerSearch
If at some point you wish to uninstall PowerSearch completely (this is sometimes helpful in troubleshooting problems with a new
version), run the Un-Installer.

Windows Demo:
https://digitalanarchy.com/demos/psd_win.html
Open the .zip file and launch the PowerSearch_Installer.exe. If you are updating or upgrading, you’ll be asked if you
want to uninstall PowerSearch. Click OK to run the un-installer. (highly recommended)
Click through the installer, agreeing to the license terms. The installer will automatically select the correct directory,
don’t change this unless you have an unusual system and you know where the panel should go.
This will install the PowerSearch panel, and associated files into:
C:\Program Files\Common Files\Adobe\CEP\extensions
Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close
the installer.
Restart Premiere Pro and PowerSearch should show up in Premiere under Windows>Extensions>PowerSearch
If at some point you wish to uninstall PowerSearch completely (this is sometimes helpful in troubleshooting problems with a new
version), run the Installer, click OK to uninstall and then cancel the Installer before it re-installs the plugin.
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Your Serial Number
After purchasing your plugin, you should see an email with the Subject: Your Serial Numbers for
Order #XXXXXX . Look for the pink highlighted text in the email and that will have your serial number.
If you own Transcriptive 2.0 or Transcriptive Rough Cutter no separate serial number will be sent to
you. Use the same Transcriptive serial number to activate PowerSearch.
PowerSearch will ask you for the serial number when you first run it within Premiere Pro.
If you have any problems, you can always contact us at cs@digitalanarchy.com or call 415-2876069
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What is PowerSearch?
PowerSearch aims to be Google for your Premiere project. A search engine that can find
anything. We index almost everything in your project (this can take a few minutes when you
first launch PowerSearch) and that allows us to easily search clips, sequences, markers, or
transcripts/captions.
PowerSearch will scour transcripts from Transcriptive or any other source, including the
Adobe Speech to Text service (they need to be saved as SRT files). It’ll save you hours of time
looking for things. You no longer have to scrub through footage looking for the clip where
“that guy, said that thing about the Anarchist”. Do a search for “Anarchist” and everywhere
that shows up in clips, sequences, SRTs or markers will get displayed to you like search results
in any search engine. Click on a search result and open that clip or sequence right to where
the search term was said. It’s pretty amazing.
Of course, you need to have transcripts, markers, or caption files for PowerSearch to do it’s
magic. Obviously we think Transcriptive, with it’s ability to use/import A.I.transcripts, is the
best way to turn all your dialog into text. However, PowerSearch is totally agnostic. If you’ve
used another tool like Adobe Speech to Text, Trint, SpeedScriber, SimonSays or any other
service* to get your transcript into Premiere, PowerSearch will search that data too! Just get
the data into Premiere and we’ll find it.
It’s a whole new way of finding things in Premiere Pro and it’s going to change the way you
work!
* Usually you import transcripts from other services (including Adobe) as SRT files into
Premiere or Transcriptive. PowerSearch will index SRT files but if you want the SRT files to
become an actual transcript linked to media, you need to import it into Transcriptive.

What Does PowerSearch Search When It Searches?
- Clips: Any clip or sequence that has a transcript in the Speech Analysis field, Adobe
Captions panel, or in the Transcriptive panel. (Some apps like SpeedScriber also put
transcripts in Speech Analysis)
- Markers: Any markers you lay down in a sequence will be searched. Doesn’t have to be
transcript data. If you’ve used markers to make notes or labels, it’ll search them. (web apps
like SimonSays put transcripts here)
- Captions: All SRTs can be searched simouteneously. Adobe Sensei transcripts can also be
searched if imported into Premiere or Transcriptive.
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Launching PowerSearch

PowerSearch is a panel, not a plugin. So you can find it by going to
Window>Extensions>PowerSearch.
When you select it, it’ll open PowerSearch as a floating panel. Like any Premiere panel you
can dock the PowerSearch panel anywhere. Leave it floating or drop it into the portion of the
Premiere UI that makes sense and somewhere you can leave it open. It’s better if you don’t
close Powersearch frequently. PowerSearch needs to index your project and this can take a
few minutes with big projects. So it’s best to put the panel somewhere in the UI where you can
leave it be.

Top: PowerSearch is docked. Bottom: Undocked, floating panel.
8
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How to Use PowerSearch for Premiere
Start Screen
The Start Screen is the first thing you see in PowerSearch. Here you can:
1) Index the entire project
2) Load indexed data that was previously saved
3) Click Search to jump to the Search screen if your project is already indexed.

Indexing - Yes! You need to read this part!
As mentioned, PowerSearch needs to index your project. Once this is done the first time, the
data will be automatically saved, speeding up the process next time you open the project. It
can still take a couple minutes to load saved data with really large projects.
When you open PowerSearch for the first time, it will let you know that the project needs to be
indexed. Click “Ok” to go to the indexing screen and index your project.

Clicking on “Index Project” wil tell PowerSearch to start looking for all the items in your
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Premiere Pro project (clips, sequences, markers, caption files, transcripts) and create a
database of the text in those itens.
If you switch projects, click on the “Load Active Project” button first to point PowerSearch to
your active project before clicking “Index Project”.
Index Project Button
Clicking on the Index button indexes your Premiere project and THIS IS REQUIRED. If you
don’t click this button, PowerSearch won’t find anything.
PowerSearch looks into all your project items to make an index of where all your text is.
This makes it incredibly fast when you go to search for something. The downside is that, for
big projects with lots of clips and metadata, it can take a bit of time to do the indexing. So
you don’t want to have to do this frequently. Luckily you can then load that data once it’s
indexed.
You can also add new items you import without re-indexing everything by using the Index
New Items button.
What Gets Indexed?
- Transcripts: Any Video/Audio File (e.g. .mov, .mp4, .aac, .mp3, etc.), or Sequence that
has a Transcriptive transcript associated with it will get indexed. (You can get transcripts from
other services into Transcriptive by importing an SRT or Plain Text file)
- Clip or Sequence Markers: Some transcription services (e.g. SimonSays) will put the
transcript data into markers but any data you put into a marker will get indexed. So if you
have notes in markers, PowerSearch will be able to find that data as well.
- SRT Files: If you use SRTs for your captions, Transcriptive will index any SRT that has been
imported into Premiere. This is a great way of allowing PowerSearch to index transcripts
generated by Adobe Sensei (Premiere’s built-in transcription service)
Load From Save Button
After your Project or specific project items (Speech Analysis or Markers) are indexed, they
will be automatically saved and added to your PowerSearch database. So there is no need
to re-index a project if you completed this process previously.
This can save a lot of time vs indexing again
If you saved a project with a new name to create a backup, or if you iterate your projects on
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a regular basis (like if I have a version of this project for November 1st and save a new version
of it for November 2nd), PowerSearch won’t detect the database in the new project even
though it has the same clips, transcripts, etc. Instead of indexing again, follow the steps below
to load the existing database:
1. Click on “Load from Save”
2. Click “Select file” and find the existing database in your “Documents/PowerSearch” folder
3. Click “yes” to load it. Now this new project has a copy of the search database.
This can save you a few minutes by not having to index everything. To manually select those
files for indexing just click on the “Plus” sign next to any un-indexed file. Once you’ve done
that you can search those clips. This makes it much faster to use if you’ve got a project with
hundreds of items and only a few of which that you actually want to search.

Search Bar
When indexing or loading dabase from save is complete, PowerSearch will automatically
open the Speech Analysis (or search) results window. Type a word or phrase in the search bar
and click on the maginifier icon to scan all itens in your Premiere project.
The window will be empty, with no results listed at first. Typing your search terms and pressing
“Enter” or clicking on the “serach” icon will load your search results.
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Under Speech analysis you’ll see the name of a clip or sequence, and any locations in the
transcript that word or phrase appears. Search results will show he timecode next to it. Click
on the text to opens the listed clip or sequence and jump the playhead to that timecode.
Any SRT files that were indexed will show up here as well. If you have captions that were
created by something like the Adobe Speech To Text Service or text panel, clicking on a
result wll scroll the captions to that position. With the text panel open, you can just use the
timecode listed to find that location in your sequence.
Using Quotes in Searches (e.g. “This has quotes”)
Like most search engines, PowerSearch supports quotes and commands (AND, OR, NOT), so
if you want to find a word exactly, say every instance of “photo” but not ‘photographer’ or
‘Photoshop’, then by using quotes PowerSearch will only return results with “photo”.
Otherwise if you type in ‘photo’ without quotes, it’ll return photo, photography, photon, etc.
You get the picture.

You can see the difference above. Without quotes, the search results return ‘hanger’ and
‘dangerous’ in addition to ‘anger’. With quotes, only ‘anger’ is returned.
Quote searches are not case sensitive, so you’ll get the same results with upper and lower
case results.
Using AND, OR, NOT
When you use AND, OR, or NOT and they are capitalized (as shown), they become
commands in your search query. Take the search term: Pink Elephant

12
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Search Query		

Result

Pink Elephant		
		

Search results only include dialog where the words Pink Elephant are
shown in that order. i.e. Someone is talking about a pink elephant.

Pink AND Elephant
			
			

These search results include any sentence where pink and elephant
are used. It could include ‘pink elephant’ but also could include ‘the
pink carpet with a brown elephant’

Pink OR Elephant
			
			

These search results include any dialog that include Pink or Elephant. It
could include both in one sentence, but if you use OR you’ll get every
sentence that has Pink in it and every sentence that has Elephant in it.

Pink NOT Elephant
			
			
			
			

You will only get dialog with the word Pink in it by itself. Sentences
with Elephant in them will not be shown. This is VERY useful if you’re
searching for a word but there is a common combination that you
don’t want. Say you’re searching for Digital, but don’t want results
with Digital Anarchy in them. You’d use: Digital NOT Anarchy.

Index New Items Button
This will look through your project for new clips and index only those items. This should be
much faster than a full re-indexing. When you add footage to a project you’ll need to click
this in order for them to be searchable. Otherwise their transcripts won’t be in the search
index.
Unfortunately this doesn’t work for Markers. If you add new clip/sequence markers and
need those added to the Index file, you’ll need to re-index individual items manually or the
entire project.

Reindexing/Adding New items Tips
An important thing to remember about searching is that the data you’re searching was
created when you clicked “Index”. Anything that’s been added or changed in the project
won’t show up, because the database was created before that change happened.
So we recommend that you make any edits to transcripts or SRT caption text, or create any
markers, before indexing. OR... do one index at the start, so you can search while you’re
editing, and then re-index completely once you’re done. Indexing is MUCH faster than it
used to be, so it’s easier to re-index multiple times than with previous versions.
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There are some changes that you can add to the search database without indexing the entire
project. Clicking the re-index button can add some kinds of changes or new data to the
search database:
- If you edit the text of a Transcriptive transcript in Clip Mode, you can click “Save”,
and then re-index, and that change will be reflected in the search results.
- If you add a new clip, create a new sequence, or add a new SRT caption file to the
project, you can click re-index and add those new items to the database.
Re-indexing new items is adding to the database only, and not subtracting, so if you delete
something and re-index, it will still show in the search results.
Re-indexing will usually be much faster than going back and indexing the entire project again
from scratch.

Search Results
PowerSearch can find indexed items in all sorts of places. The usual suspects are:
Markers: It will search both clip and sequence markers. Markers are displayed a bit
differently than other results. PowerSearch will show the timecode, name, and text content of
the marker.
Clips: Clips may have their transcripts stored in a variety of places. In the Premiere project
itself, Speech Analysis, and a JSON sidecar file next to the clip. PowerSearch will look at all
these.
Sequences: PowerSearch will also search Sequences and show where a search term appears
in the sequence. For Transcriptive, the Sequence transcript lives in the Premiere project itself.
For other apps, often they will put the transcript in Markers (SimonSays) or use SRTs (Adobe
Sensei).
Captions: If you have your captions in SRT files, PowerSearch will index those and search
them. You’ll get the results timecode so you know where to look for them. These are not
clickable, as we don’t know what sequence the SRT file is in. However, you can use this to
quickly locate the time the caption is at and manually open the correct Sequence to that time.
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Refining Your Search
If you search for a word or phrase that appears a large number of times, in different places,
PowerSearch will give you the option to Display the results or refine the search.

Click “Display” to see a full list or “Refine” to skip loading all of the results and search again
right away. This is when search commands like Quotes, AND, OR, and NOT come in handy.
They allow you to narrow down your search and not get as many results, making it easier to
find exactly what you’re looking for.
For large projects, displaying all results may return a massive amount of items, which may
not be convenient when trying to find content faster. PowerSearch warns you that it may be
easier to refine your search terms to display a more targeted list of search results.
Displaying Search Results
Still blotchy, needs more smoothing.

The search results are displayed in two sections:
- Speech Analysis:
This shows results for clips and sequences. In each case, PowerSearch shows the file/
sequence name, the timecode where the search term is spoken, and a short bit of text before
and after the search term to provide some context.
Results from SRT files you have in your project will also show here. This will display
the text and timecode of the search result. You can then locate the Sequence the SRT file is
part of and open it. Unfortunately, clicking on the search result will not automatically open the
Sequence. We do hope to improve both the types of caption files we can search and add the
ability to click on them by the next version of PowerSearch.
- Markers:
This shows both clip and sequence markers. In each case, PowerSearch will show the file/
sequence name, the timecode where the search term is spoken, and a short bit of text before
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and after the search term to provide some context.
Clicking on Search Results
As with any search engine, clicking on the search results takes you to where that result links to.
Clips (in the Speech Analysis section of the results): If the search result is in a clip, the clip will
be opened in Premiere’s Source panel and the playhead will jump to the time of the search
result.
Sequences: If the search result is a sequence, that sequence’s timeline panel will be opened
and the playhead will jump to the time of the search result. (Actually two seconds before
where the word is spoken).
Markers: If it’s a Sequence marker, clicking opens the Sequence the marker is in and moves
the playhead to that marker. If it’s a Clip Marker then it’ll be opened in the Source panel.
Captions: this is more for informational purposes. If you click on it, it’ll open the caption file
itself which isn’t as useful as it could be. So find the result you’re looking for and manually
open the Sequence to the time noted in the search result.
Switching Between Projects and working with Productions
If you’re working in a Production, Open the project you want to search, and then click “Load
active project”, then “Search” or “Index”.
If you click index with a project that already has been indexed, PowerSearch will warn you
that you’ll overwrite the existing search database with a new one, which can potentially take
a long time. If you stitch projects in Premiere, you can click the “Load Active Project” button
on the Search Screen or the “Load Active Project” button on the Home Screen.
You can see which project is currently being search next to “project being searched:” under
the search bar.
If you switch to a project that hasn’t been indexed, PowerSearch will alert you that it needs to
be indexed before you search.
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Troubleshooting section
My project is taking a really long time to index
You may have too many files in your Premiere project. If you start getting over 1000 items
in a single Premiere project, PowerSearch is going to take a long time to index it. Frankly,
Premiere usually becomes difficult to work with if you have so many items, so you might want
to consider breaking things up a bit.
Also, when indexing, try only indexing Markers or Speech Analysis. This will cut the
indexing times down and only index what you actually need to search.

What happens if PowerSearch or Premiere closes while indexing?
The index will only be partially complete. Reopen PowerSearch and/or Premiere Pro to click
on “Index” and start the indexing process again, from scratch.
You can also click on “Index New/Modified” to automatically add the missing items.
However, if indexing new/modified items is taking too long, it’s recommend to index from
scratch just in case the database wasn’t correctly saved during the crash.

PowerSearch panel has gone blank
This usually indicates the panel has crashed. Close the panel and restart it. You might want to
restart the computer as sometimes this can indicate that memory has gotten overloaded. A
restart will clear out memory which does wonders for applications. (that’s why every support
person has you restart your computer)

PowerSearch panel keeps reverting to the Start Screen
This usually indicates the panel is crashing. Try restarting your computer. If you’re trying to
Load from Save, you may also need to re-index from scratch. Sometimes the index file gets
corrupted and the best solution is just re-index.
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Other Support Resources
Video tutorials: https://digitalanarchy.com/premiere-search/tutes.html
FAQs: https://digitalanarchy.com/premiere-search/faqs.html
Email support: cs@digitalanarchy.com (7 days a week)
Phone support: 415-287-6069 (Usually 10-5 PST, Mon-Fri)
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